VI'P (Alapok)
_3(vFP_6)
I Adiibizis és thbla kezelés AD 3(
AYBC = DataBase Container, (¢s DCT, .DCX)
Honnei nevek, Megjegyzések, Feliratok (Caption) a mezékhéz (Browse, Grid), Alapérték, Mezd és rekord

nzintl szabilyok, Tablak kozotti relaciok tarolésa, Triggerek — INSERT, UPDATE, DELETE, procedurak,

knpesolat a thvoli adatforrashoz,

CREATE DATABASE proba

CREATE TABLE partner (nev ¢(35), cegnev ¢(35) PRIMARY KEY cim ¢(60) )

CREATE TABLE ceg (cegnev c(35), cegeim ¢(60), ctelefon ¢(40),
FOREIGN KEY cegnev TAG cegnev REFERENCE partner)

MODIFY DATABASE

CLOSE DATABASE

USE proba.dbc

BROWSE

Adatbizis létrehozisa
CREATE DATABASE partner

Adatbizis hozzdadisa a PROJECT-hez és eltavolitisa
Project Manager-ben Databases ikon, Add, Remove.

Adatbézis tbrlése a lemezrol
Project Manager-ben Databases a Remove gombot, -> Delete.
Vagy DELETE DATABASE partner

Adatbazis lezarasa
CLOSE DATABASE partner

Keresési sorrend

OPEN DATABASE partner

USE ceg

El6szor a pariner nevill Adatbazisban, aztdn az alapértelmezett utvonalon,

Az adatbdzis és tdbla linkek frissitése (pl. ha dtmozgatunk a tiblakat egy masik kényvtarba)
OPEN DATABASE pamer
VALIDATE DATABASE RECOVER

Az adatbazisban tarolt rutinok
PL: A Database Designer: Edit Stored Procedures.

AB hivatkozasi egységének megorzése (RI— Referential Integrity)
Olyan szabalyokat kell létrehozni, amelyek megvédik a tablak kozotti reldcios kapesolatot, ha a tablakbol
torlunk, vagy felvisziink rekordokat.

Elsédleges kules <—> kiils6 kules,

RI generator,

Database Designer -> Edit Referential Integrity -> Referential Integrity Bulder. Oszlopok: (Parent
Table, Child table, Update, Delete, Insert, Parent Tag, Child Tag).

A tulajdonsagagok lekérdezése és bedllitasa
7 DBGETPROP (“proba”,"database”,” Version™)
= DBSETPROP (“proba”,”database”,”comment”,”Ez a megjegyzés!™)

Thbla létrehozisa
AB_Tabla letrehozisa

OPEN DATABASE
CREATE TABLIE ceg (nev ¢(30) )

Szabad Tiabla létrehozisa !
CREATE TABLE ceg FREE (nev ¢(30) )

Vagy-
CLOSE DARABASES
CREATE TABLE ceg (nev ¢(30) )

A tabla elnevezése (128 karakter), 1étrehozisa, valtoztatisa:

CREATE TABLE ceg NAME cégek_adatai (nev ¢(30), cim ¢(40) )

CREATE TABLE ceg NAME cégek_adatai {nev ¢(30) NOT NULL, cim c¢(40),
szémlakelt D DEFAULT DATE( ), kod N(4) )

ALTER TABLE proba ADD COLUMN ( kor n(2) )

Tabla hozzdadisa az AB-hoz
OFEN DATABASE partner
ADD TABLE ceg

Tabla hasznalata AB kapesolis nélkiil
USE partner|ceg
BROWSE

Tabla eltidvolitasa az AB-bél
OPEN DATABASE partner
REMOVE TABLE ceg // nem torli fizikailag a tablat 11!

AB_Té#bla fizikai torlése (a memo.FPT és strukturalt index .CDX is)
OPEN DATABASE partner
REMOVE TABLE ceg DELETE

Hogy he keriiljenck a lomtirba:
OPEN DATABASE partner
DROP TABLE ceg NORECYCLE

Szabad Tibla tirlése
DELETE FILE ceg.dbf

Megjegyzés flizése a mezéhiz
=DBSETPROP( "proba.nev”, "field”, "comment”, " Az tigyfél neve™)

Felirat megadds a mezdihiz
=DBSETPROP( "proba.cim”, "field”, "caption”, "Utca, hédzszam™)

NULL érték hasznalata
CREATE TABLE adoérték (afa n(5,2), alap n(10) NULL, adé n(15) NULL)

A mezo alapértékének beallitisa

CREATE TABLE adoérték (afa n(S,2) DEFAULT 25, alap n(10) NULL, ado n(15) NULL)
Ha a tabla létezik mar:

ALTER TABLE addérték ALTER COLLUMN éfa SET DEFAULT 25

Mezd szintii szabaly megadisa
ALTER TABLE proba ALTER COLUMN datum SET CHECK datum== DATE()
ERROR "A datum nem lehet nagyobb a napi datumnal!™

Rekordszintii szabaly megadisa
ALTER TABLE proba SET CHECK szildatum < érettségid
ERROR "Hibas datum!™




Ellendrzés Indiths o INSERT, UPDATE és DELIETE esem énycknél
CREATE TRIGOER ON geg FOR INSERT AS alaptdke < 1000000
CREATH TRIGORR ON oog FOR DELETE AN jogosuli( )

Ellendrzén inditis 10rlose
DELETH TRIQUER ON probn FOR UPDATH

A tabln strabtden modositinn
MODIFY STRUCTURE vagy
ALTHR TABLE

TABI mognybtdun éu lezdrdsn egy munkacsntornirn
USH cog IN O

USH cep
BROWSH
UBKE IN cep

Cuntornira viltds
SELECT 1

USE ceg

SELECT 2

USE termek
SELECT 1
BROWSE

SELECT 0
USE ceg
SELECT 0
USE termek
SELECT ceg
BROWSE

Hivatkozds egy masik csatorna tabldjdra
SELECT ceg

SET RELATION TO cegkod INTO termek
BROWSE FIELDS cégnév, termek.terméknev

REKORD KEZELES, INDEX, RELACIO
Rekord kezelés

APPEND BLANK INSERT-SQL REPLACE
APPEND FROM vagy IMPORT APPEND GENERA

DELETE-SQL RECALL PACK ZAP

Indexek
Strukturalis .CDX, Nem strukturdlis CDX, (TAG) egyszerii .IDX

Primary (elsédleges), Candidate (vizsgalt), Unique (egyedi), Regular (dltalinos).

INDEX ON ara TAG aralap OF spec /f spec.cdx
ALTER TABLE ceg ADD PRIMARY KEY cegnev TAG cegnev

Adatok indexelése

USE termek

INDEX ON orszag+varostutca TO telep
INDEX ON termek +DTOS(ido) TAG term

A velordok sorrendjének beallithsn
ST ORDER TO vegney
BROWSE

UBE nevek INDEX nov, ceg, beosztas

PL Henderl Click:  SET ORDER TO oégnédy — Thisl'orm Relresh
Hender2 Click:  SET ORDER TO kaposolat — Thislorm Refresh  Henderd Cliok
ciml Thislorm Refresh

ANULL értékek eldl vannak.

Forditott sorrendd index
INDEX ON téke TAG alap DESCENDING

Meglevd index forditott sor.
SET ORDER alap DESCENDING

INDEX térlése
USE konyvek EXCLUSIVE
DELETE TAG szam

USE konyvek EXCLUSIVE
DELETE TAG epyfo OF scec] // nem strukturalt

Elsédleges kulesot:
ALTER TABLE DROP PRIMARY KEY

DELETE FILE inf /1 IDX torlése

Adatok sziirése

USE ceg

SET FILTER TO UPPER(cim 1)="EGER”
SET ORDER TO cegnev

GO top

SELECT ceg

BROWSE

Ideiglenes relaciok kapesolata
SELECT 1

USE orszag

SET ORDER RO orszagjel

SELECT 2
USE termek
SET ORDER RO terméknev

SET RELATION TO gyartoorsz INTO orszag
BROWSE FIELDS terméknev, orszag.orszdgnev

SET SKIP TO konyv

Allandé relacibs kapesolat
ALTER TABLE partnerek ADD FOREIGN KEY cnev TAG cnev REFERENCES ceg

ALTER TABLE partnerek DROP FOREIGN KEY cnev SAVE // kapesolat torlése
Tabla megnyitisa kizdrdélagos hasznalatra

SET EXCLUSIVE ON
USE proba

SHET ORDER TO




LINK praba BXCLUSIVE

Ar EXCLUSIVI n kiivetkezd parancsokhoz kell:

ALTHR TABLIE INDEX INSERT

MODIFY STRUCTURE PACK REINDEX ZAP
Adutol ongtott hnszndlata

TAbIn megnyltisn osztott haszndlatra

AT BXCLUSIVE OFF

LA proba

vilgy
LK proba SHARED

Automatikus zarolas

ALTER TABLE, APPEND, BLANK, BROWSE (CHANGE, EDIT), DELETE,
GATHER, INSERT, INSERT-SQL, MODIFY MEMO,
READ, RECALL, REPLACE, UFDATE

Manuilis zirolas

FLOCK(), RLOCK() vagy RLOCK(NrecordLista, Munkacatorna)

LOCK == RLOCK

SET REPROCESS TO n SECONDS

ISRLOCKED() ISFLOCKED() a zérolas statuszat kérdezhetjik le.

Pl. RLOCK(], 2, 5, 17, ,,szamla™)
Pl SET EXCLUSIVE OFF
SET REPROCESS TO 0
USE ceg
IF FLOCK()
REPLACE nev WITH UPPER(nev)
UNLOCK
ELSE e
WAIT WINDOW |, SIKERTELEN ZAROLAS !”
ENDIF

A zirolds feloldiasa

UNLOCK, UNLOCK ALL

SET MULTILOCK OFF - amikor zéroljuk a rekordot, az el6z6 zérolt rekord felszabadul,

CLEAR ALL, CLOSEALL, USE, QUIT, END TRANSACTION, TABLEUPDATE()

Az adat munkafizisok (data session) hasznilata

Az egyes pépek (ablakok) adat munkafazisa figgetlen egymastol,

Sujit adat munkafézis létrehozdsa:

Tu'ajdonsag  DataSession =1 vagy 2

1 - Defaukt data session , alapértelmezés (az ablakok DataSession tulajdonsdga alapesetben ez),
2 ~Private data session - sajat adat munkafazis.

Az ndal munkalizis kérnyezetének beallitasai

Kk I ANSI, BLOCKSIZE, CENTURY, CONFIR DATABAGSE,
DECIMAL, DELIMITERS, EXCLUSIVE, FIXED, LOCK, MEMCWIDTH,
NEAR, POINT, SAFETY, SEPARATCR, TALK, AUTOSAVE,
CARRY, COLLATE, CURRENCY, DATW, DELETED,
HXACT, FIRLDS, HOURS, MARK TO, MULTILOCKS,
ML, REPROCES,  SECONDS, SYSFORMATS, UNIQUE.

Attt pufferolisa
c U d vagy Tabla pulferolds
Amiste vagy optimista pufferolas

Pesszimista pulferolas — a VFP megakadalyozza, hogy az egyik felhasznald dltal pufferolt rekordot & tébbi
felhaszndld modosithassa,

Optimista pufferolds — a VFP csak a visszalrds idejére zdrolja.

A pufferolis bedlliitisal,
=CURSORSETPROP(, Buffering”, n)
1 - Nines pufferolis (alapértelmezés)

2 - Pesszimista rekord pufferolds

3 - Optimista rekord pufferolas

4 - Pesszimista tabla pufferolds

5« Optimista tabla pufferolas,

A TABLEUPDATEY) fliggvény
TABLEUPDATE(Nsor, Erdsség, Tabla, HibaTémb )
Nsor =0 csak az aktualis rekordot irja vissza a pufferbdl a tablaba, =1 - minden rekordot, =2 - minden
rekordot, de nem jelez hibat,
Ertsség T, —a tobbi felhasznald altal megvaltoztatott adatokat feliilirja,
F. ~ hibét jelez, és leall a rekordok frissitésével, ha egy rekordot mas megvaltoztatott.
A hibakat ON ERROR rutinnal lehet lekezelni.

TABLEREVENT() fiiggvény
TABLEREVENT(MindenSor, [ Tabla])
MindenSor - .T. a pufferben 1évd minden rekord, .F.~ csak az aktudlis rekord médositasait veti el.

Rekord hozzafiizése a pufferhoz
=CURSORSETPROP(,Buffering, 5)

GO7

REPLACE nev WITH UPPER (nev) //7 rekord
SKIP

REPLACE nev WITH UPPER (nev) // 8 rekord
SKIP

REPLACE nev WITH UPPER (nev) //) 9rekord
SKIP

APPEND BLANK

APPEND BLANK

APPEND BLANK

Puffer:

7 rekord szerkesztés
8 rekord szerkesztés
9 rekord szerkesztés
-1 Ujrekord

-2 U] rekord

-3 Uj rekord

Az elsd hozzaflizott rekordot a GO -1
A SEEK a negatlv sorszamu pufferolt rekordokat is elemzi.

=TABLEREVENT(.T.) - A hozzafiizott rekordek torlése a pufferbol. Ezzel a tébbi rekordok modositasa
is elveszik,

APPEND BLANK

DELETE

=TABLEREVENT(.T.)

A rekord bekertl a tiblaba, de torolt jelzés( lesz!

Hibakezelés

ON ERROR DO hibkez WITH ERROR(), MESSAGE()
SET REPROCESS TO AUTOMATIC

[§




USE nejopy SHARED
REPLACT nev WITH UPPER(nev)

PROCEDURE hibkez
LPARAMETERS hibanzam, szovey
1 hibpszam = 109 QR hibawzam = 130

vl =M ESSAQRHON (naoveg + CHRCD U m mogprobaljn?”, 44 921 346)

11 vilnnz=6
RETIRY
INTLI
HNDLE

A pulferolin slatt megvaltostatoft velordal moghorosae
CURVALQD -~ oy ndott merd nkiudlis, o tbldban elthrolt ériékét lekérdezi

OLDVALQ « ey ndott mezd nzarkenatén 16t dllapotdt kapjuk,

Tranenlelol

BEGIN TRANSACTION

ROLLBACK

END TRANSACTION

A tranzakoid tdeje alatt nem hasznalhatok MODIFY STRUCTURE, INDEX.
A tranzakoid nem vonatkozik a tvoli (remote) adatbazisokra. Lehet végrehajtani:

SQLSETPROPO), SQLCOMMIT(), SQLROLLBACKY() figgvényekkel.

Egymasba illesztett tranzakeidk (5 szint),

TXNLEVELQ
Pl: DO WHILE TXNLEVEL()=0
ROLLBACK
ENDDO

OBJEKTUM ORIENTALT PROGRAMOZAS

—

Osztily (Class), Tulajdonsdg (Properties), Eseményck (Events), Metédusok (Methods),

Qjektum alosztalyok.

A VIP fontosabb alaposztalyai

cuoport )
Page Lup van tirold Objektum (nem
ablak)
Pagelrame Linpheret nines tirold Page
Neporator Lihvilnnzt o Vi verdrlon
Nhipe N Alubant vin verbrlén
Splaner - Glirgetimerd vin vorbrlén
ToxDox Sadivegmoezd vimn venbrlén
Timer Lddzitd nines verdrlen
ToolBar sz kdzsor Yin throld Ohjektum (nem
PR LT T | nblnk)
Hivatkozis,
Abszolat Hivatkozdis:
Form1.Pagelramel. Page1.Grid1.Columnl.BackColor=RGB(0, 255, 0)
Relativ Hivatkozas.
Parent, THIS, THISFORM, THISFORMSET
Az objektumok tulajdonsigainak beallitisa
Szill6.0bjektum. Tulajdonsag = firték
frmTelefon.txtDétum. Value = Date( )
frm Telefon.txtDatum BackColor = RGB(128, 128, 128)
WITH frmTelefon txtDatum
.Value = Date( )
BackColor = RGB(128, 128, 128)
ENDWITH
A metodusok hivisa
Szuld, Objektum. Metddus
frmTelefontxtDatum. Refresh
THISFCRM.Release
A fontosabb események
Esemény Bekivetkezésének oka
Load Munkanblak (készlet) a memoridba téltddik
Unload Munkaablak (készlet) tirlédik a memoridbél
Init Az objektum létrehozd:
Destroy Az objektum torlédik a memoriabol
Click Kattint egérgombbal
DbIClick Kitszer kattint egérgombbal
RightClick Misodlagos egérgombbal kattint
GotFocus Az objektum fokuszba keriil (Tab-bal, SetFocus
metodussal)
LostFocus Az objektum Kikeril a fokuszbol (Tab-bal, mas
objektumra Kattintott, SetFocus metédussal)
KeyPress Egy billentyiit leditott
MouseDown Lenyomta az egér gombjat
MouseUp Felengedi az egér gomhjat

Név Magyar név Megjelenités | Tipus Tartalma

CheckBox Vilasztomexd Nincs vezérlés

Column Oszlop Van tirold Header, objectum

(nem ablak)

ComboBox Kombindltmezd van vezérlés

CommandButton Parancsgomb van vezérlés

CommandButtonGroup Parancsgomb van tarolé CommandButtom
csoport

EditBox Szerkesztomezd van vezérles

Form Munkaablak van tarolé PageFrame,

vezérlések, tarolok

FormSet Munkaablak van tarolé Form, ToolBar
készlet

Grid Ricshald van tarold Column

Hender Fejlée van vezérlés

Image Kép van vezérlés

Label Cimke van vezérlées

Line Vonal van vezérlés

ListBox | Listamezd van vezérlés

OptlonButton Vilasziogomb van vezérlés

OptionGroup Vilasztogomb van tarold OptoinButton

<késébb c.83-,.>

Munkaablak. Ablak készlet

A VFP az ablakot tarolja .SCX féjlban, a memo- ¢

Az adat kornyezet kijelolése
View (menii), Data Enviroment

pontban.

Az objektum értéke interaktiv iton megvaltozott

Az objektum értéke programsorbdél megvaltozott

g ROy e s o i Y



Az adat kdrnyezethez kapesolodd tulnjdonsgok:
AutoClosetables - T, (alap),
AutoOpenTables « T, (alap),

Initinl Selected Al ~ legelbazdr hozzhadott thbln (lap).

Tablo vagy mezd dthelyozdae nz ablakra (egdrrel)

Thbln < Crid

Logiknl mezd  « Checkox

Mamo mezd
Hydb mozik

Lo definlalt Konntanvok
HDEFINE - Nmax 100

Tulif donsig bodllithsn
Thin Caption = Beal( )

« it ox
< TextHox,

ASELOBIO uggvény tombot hoz létre, elemei a Form Designer-ben kivélasztott objektumok

N = ASELOBJ(tomb)

FOR 1#1 TO N
tomb(1). BackColor = RGB (128, 0, 0)

ENDFOR

Tulajdonsag Leiras Alapérték Ertékkészlet

AlwayaOnTop LT, — mindég ,fent” e {8 R

AutoCenter T~ afé VFP ablak F T, F

kbézepén

BackColor Hittérszin RGB(255, 255, 255) 0-255,0-255,0-255

BorderStyle Ablak kerete 3 0-nincs keret, 1- egyszeres, 2-
dupla, 3- System keret

Caption cimsor Form1

Closable A felhaszndlé bezarhatja | .T. 14t N T

az ablakoet

DataSession 1 1 —ablak nem hasznél, sajit
munkafazist, 2- igen.

Desktop . .T. ~az ablak a Windows
asztalon barhol lehet, F- VFP 6
ablakdin lehet

MaxButton van maximalizilé gomb Ak T

MinBuiton van minimalizaléo gomb i1 Tk

Movable mozgathatd T T,F

TitleBar van-e fejléc 1 O-pincs, 1- van

WindowState dklapot 0 0-normal, 1-ikon, 2-maximalis
méret

WindowType Tipus 0 0-nem modalis, 1-modalis

A 16 VI'P ablalk elejtése
A Init eseménybe kodot:
Application, Visible = .F,
A Diestroy eseménybe:

Application. Visible = .T,

Abluk futtatisa:
27 RM form 1

ANt ablak lezarasa:
P ASE THISFORM

wpernyrl:
RM. Hide

i THISFORMSET

Ablak1 Hide (vissza: Ablak1.Show)
Bedllitasole

SCREEN Ablakl Nyom&1,Caption="OK"
THLS Caption="OK"

WITH THIS

Caption="\<Kildpés"

AutoSize=.T,

Picture="CAWINDOW S\zigzag bmp"
ENDWITH

Vezérlésck haszndlata
Vezérlések  buborék szévegének” beallitasa: ToolTipText

Vezérlések valaszthatosiga: Enabled
Ablak].Gombesoport Enabled = F.  //a gomb nem valaszthato!

Megjelend képek beallitisa:

Bitmap bmp
Device Independent Bitmap Jdib
Graphics Interchange Format gif
Joint Photegraphic Electronic Group Jre

Cursor .eur
Animated Cursor .ani

ITeon Jdco

A vialasztogomb csoport (t6bb lehetoségbdl pontosan egy lehet! )
ButtonCount — csoport gombjainak szama.

A valasztdgomb csoport 9sszes gombjénak egyidejli tulajdonsag :
Ablak.op,Csoport.SetAll.(,Enabled”, F., ,OptionButton™)

A Kivilasztott gomb meghatarozisa

Value tartalmazza a sorszamot (3).

A felhasznaldi vélasztds eltaroldsa a tbldban

ControlSource - numerikus Value=0, vagy karakieres mezd (valtozd) Value=""

A listamezd és leg ordiilé listam ezd hasznalata
A legordild listamezd olyan kombindltmezé, amelynek Style tulajdonsagat 2-Dropdown-ra allitottunk.

ColumnCount - oszlopainak szama,

ControlSource — a felhasznaldi valasztist eltdrol tibla mezdt (valtozot),
MoverBar - balszélen mozgatd gombok megjelenjenck-e,

MultiSelect - egynél tobb elemet lehet-e kivalasztani,

RowSourse — lista elemeinek forrasa,

RowSourseType - tipus.

Value numerikus vagy karakter lehet,

A lista fontosabb metodusai

AddItem — A RowSource=0 esetén, 1j elemet a listahoz

Removeltem - A RowSource=0 esetén, torolhetink egy elemet a listdbol
Requery — Felfrissiti a listat, ha a RowSource értéke megvaltozott.

Lista vagy kombindltmezé feltdltése elemekkel

RowSourceType:

0 -None Nines, Programbol adunk elemeket.
1 -Value Megadott értékek.

2 - Alias Alias,

3 - SQL statement SQL utasitds.

4 - Query Lekérdezés (QFR,

5~ Array Témb.
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6 Ields Mezdk.
1 Iiles Iile.
N Strueture Struktiira,

0 Popup

RowSourceType=0

nblak Listal, RowSourceType =0

nblak Listal Additem(,Els6 elem™)
nblak Listal Addltem( ,Masodik elem™)

uI‘;Iul\:LismI.Removeltem(lj /i tarli az elsd elemet

RowSourceType=1
ablak Listal, RowSource = ,.egy, ketté, hirom”

RowSourceType=3
ablak.Listal, RowSource = ,,SELECT * FROM termek INTO CURSOR Listal™

RowSourceType=4
ablak.Listal, RowSource =, termek.qpr”

RowSourceType=5
ablak.Listal. RowSource = "THISFORM témbnev” // Pl. az ablak Init eseményben

RowSourceType=6
ablak Listal. RowSource = ,alias.mez81, mez02,.. " vagy ,mezd,..”

RowSourceType=7
ablak Listal. RowSource =, *.dbf”  // aktuakis konyvtar

Tébb oszlop megjelenitése
ColumnCount=0Oszlopok széma
ColumnWidths=oszlopok szélessége

ablak Listal. ColumnWidths =710, 15, 307
Hasznéljuk a fix betiiszélességli fontot (FontName) |

T8bb elem kivilaszthatosiganak beallitisa
MultiSelect=T,
Pl FOR 1=1 TO THISFORM Listl ListCount // elemek szama
IF THISFORM.List1.Selected( 1) // selected()=T., haki van vélasztva
9 THISFORM Listl. List(i) // List(i) — a lista i eleme
ENDIF
ENDFOR

A rekordok kozitti mozgés a lista elemeinek kivalasztasival
RowSourceType=2 vagy 6 - a kivalasztas utan a rekord mutatd automatikusan a rekordra all.
RowSourceType=0, 1, 2, 4, 5 — A listamez6 InteractiveChange esemény kadjdban magunknak kell gondoskodnia
rekord mutatd mozgatasaral.
Pl SELECT termek
SEEK THIS. Value
THISFORM.Refresh

ICép hozzandisa a lista elemeihez — Picture bedllitdsaval

A kom bindltmezé hasznilata

A kombindlimezd a listamezd és a szévegmezd funkeidjat stvdzi, Két tipusa van: a legorduld kombindltmezd
(Ivop-down Combo) és a legordilld listamezd (Drop-down List).

Hiyle « hatirozza meg a tipusat.

A Do hed il kombiniltmezé — lista elemekbil valaszthat, vagy Gj értéket vihet be.

11

Style=0 legorduld kombindltmezd (alapérielm ezds),
Style=2 legdrduld listamezd,

A legbrd(ld kombindltmezo Hstdjahoz af értéhet vihettink bet
THIS. Additem(THIS, Display Value)

A kombindltmez6 tulajdonsigai:

ControlSource

Incremental Search — timogatja-¢  folytonos kereséat (DIOFA - D1.0.)
RowSource

RowSourceType

Style =0, 2.

Vilasztomezd
Logikai értékekre jo.
Igaz — bekapesolt, hamis — kikapesolt.
Value hatérozza meg az éllapottot 0 (F.), 1(T), 2 (NULL)
ContolrSource - a tdbla logikai mezdje

Szivegmezd
A bevitt adat ellendrzése a Valid eseményhez tartozd eljaras:
IF CTOD(ThisValue)<DATE()
=MESSAGEBOX(,,Csak a mai datumnal (" + DTOC(DATEQ) + ,,) nagyobb adhaté meg!™)
RETURN F.
ELSE
RETURN .T.
ENDIF

A kivilasztott szivegmezd jelzése
A GotFocus (Fékuszba keriilés) és LostFocus (fékusz elhagydsa) megvaltoztathatja a
ForeColor-t és BackColor-t,

A szdveg kijeltlése

A GotFocus-ban toroli az adatot:

THIS. SelStart = 0

THIS.SelLenght = LEN( ALLTRIM( THIS. Value))

vagy

Format tulajdonségban K beallitani!

InputMask - szdveg formdzasa ,,999,999.99” lehet 1.000.000-nal kisebb érték.

Jelszo bevitele
PasswordChar - * vagy mas karakter
A képernytn a csak *-rek lesznek.

DisabledBackColor - a nem vélaszthatd szovegmezd hattér , papir” szine,
DisabledForeColor — a nem valaszthatd szévegmezd eldtér ,tinta” szine,
SelectedBackColor - a kivalasztott szoveg héttér szine a szovegmezdn belul,
SelectedForeColor — a kivalasztott széveg elétér szine a szovegmezdn belill,
TabStop ~ a Tab-bal fokuszba hozhatja-e.

A szerkesztd mezd

(Pl. Memo-ra jo!)

Lehet nyil billentytikkel, PgDn, PgUp, gorditd séav

ControlCource —a mezd nevét.

SelStart — a kijelolés hanyadik karaktert8l kezdddik,

SelLength — a kijelolés karakterek szdma,

Programbol:

Ablak. Szerkesztdmezd, SelStart = 0

Ablak. Szerkesztémezd. SelLength = AT (" 7, Ablak Szerkesztémez6 Value) - 1
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A kijelolt szoveget megvénltoztaini n SelText-tel lehet (n HideSelootion = 11 mellet),
Ablak.Szerkenztdm ez SelTaxt = UPPER (Abluk S zerkenztmezd, SolText)

AllownTabn - lehetse a nzovepbe TAD husendlnt, Fa =T, 0 mezdbil o CreltTab lohet kilépni,
HideSelootion « nz drtdk klemelten Htseddjék e nautdn, hogy oz elem alvenztotte u [Gkunzt,
RendOnly - nem lehet megyaltoztatng,

SorollFam I'nﬁ(ﬁlugnn ROrgotiniy

Cillrgettmond
Numertkus érték nz ncdott hathrok Kozl
KeyBoardighValue ( Hpinner HighValue) - mag,
KeyBoardlowValue ( SpinnerlowVilue) - min,
Inorement - a mexd drtdke manyivel viltozik,

Parnnesgomb és paranesgomb esoport (nyomogomb)
Cuplion
Dinnbledloture — n kép nove, nmelyik megjelonik o gombon amikor az nem vélaszthato,
DownPloture - o kép nove, amelyik megjelenik a lenyomott gombon,
tinnbled - w gomb vilnazthatdee,
Pleture — w gombon megjelend kép neve,

A patanesgom b csoport throld objektum.
ButtonCount szimi gombot foglal magdba. Value tartalmazza, melyik gomb volt kivalasztva.
A anoport Click-ben;
DO CASE
CASE THIS. Value = 1
*az elsd gomb
CASE THIS Buttons(THIS. Value). Caption = ,Nyomtatas”
*Nyomtatas

ENDCASE

Az id6zitd vezérlés (Timer)

Az id6zith vezérlés egy ablakhoz, vezérléshez,..., lehet kapesolni,
Interval tulajdonsag 0..2147483647 (> 24 napl) 1/18 mp pontossag.
Enabled T .- az idézitd mlkédéshe lép.

1000 - 1 mp,

A képvezérlés
Picture - a kép file,
BorderStyle — keret legyen-e,

Stretch - 0-Clip, csak a vezérlés keretben jelenik meg, 1 -Isometric, a lehetd legnagyobb méret, 2 -Stretel,

teljesen kitdlti a megadott keretett,ha szikséges nyUjtéssal.

Specinlliffect - ogyszert vagy 3D,

Grafilkus Informaclok megjelenitése metodusoliknl (w Form-ban)
Chroles kor, ellipszin, korly,

il = lotorli o gralikit, nzdveget,

Lina - vonal,

Puat -~ pixel Allithatd n wzinbe,

Print -~ Koraktersorozatot Ir ki az abluakra,

PL,

ablok“CREATEOBJECT(, gralika")
ablak, Visible=.T,

READ EVENTS

DEFINE CLASS grafika as Form
Visible=.T.

Left=100

DrawMode=2

FillStyle=0

PROCEDURE Click
THISFORM.Cls
THISFORM ForeColor=RGB(RAND() * 255, RAND() * 255, RAND() * 255)
THISFORM BackColor=RGB(RAND() * 255, RAND() * 255, RAND() * 255)
X= THISFORM Width/2
Y= THISFORM Height/2
=MIN(X.Y)/2
FOR i=0 TO PL() STEP PI()/20
THISFORM.Circle(RX+8IN()*100, Y +COS()*100)
ENDFOR
ENDPROC

PROCEDURE RightClick
THISFORM Cls
THISFORM ForeColor=RGB(RAND() * 255, RAND() * 255, RAND() * 255)
THISFORM BackColor=RGB(RAND() * 255, RAND() * 255, RAND() * 255)
X=THISFORM. Width
Y= THISFORM Height
FOR i=0 TO X STEP 5
THISFORM.Line(0, i, X, Y-i)
ENDFOR
FOR 1=0 TO Y STEP S5
THISFORM Line(0, i, X, Y-i)
ENDFOR
ENDPROC
ENDDEFINE

Cimke (Label)
Caption,
AutoSise,
BackStyle — atlatszo-e legyen,
WordWrap - szoveg tbb sorba tordelhetd-e.
Vonal

BorderWidth - hany pixel vastag,
Line Slant ho nem figpdleges vagy vizszintes, meghatarozza a dilés irdnyat (/) vagy (\).

Alakzat
Curvature -sorkok lekerekitése. 0,99, 0-derékszogh, 88 kor (ellipszis)
FillStyle  atlituzo-e, vagy mintaval van kitéltve,
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Ricshialo

Racshilo - Oszlop -> (Fejléc, vezérlések)

ColumnCount ~oszlopok széma,

Adatok forrasa:

A rdos adatforrdsa: RecordSourceType = 0 (Table) . RecordSource-ban adott tabla, RecordSourceType = 1
(Alias) mar megnyitott tabla mezdit jeleniti meg.

Az oszlop adatforrsa: a ControlSource a mez6 neve.

Egy-a-tibbhoz ablak hasznalata a racshilé segitségével,
A gyerek tabla a rdcshalon, a szil8 mezd rekordja egy szévegmezdben.
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A Data Enviroment Designer-ben ragadjuk meg a 52018 tdbla mezdit == én az ablakra. Majd ragndjuk meg a
kapesolodd gyerek tablat és - az ablakra, Lehat a rdes vezérlén tulnjdonsigaival is:

RecordSource - gyerek tibla,

LinkMaster — az elatdloges, sz016 thbla,

ChildOrcer - a kapasolodd tabla index Tagsjn,

RelationalExpr o gyerek tablit az elsddleges thhldhoz kinponold lifejezdn

Vezbrlések hozzdndisn wz oszlopokhos

Az oszlopok vezérléseket in tartalmazhntnak: seovegmed, gorgetomerd, lstamesd, valaxatd mesd, srb,
Object ~ oszlop abjektumn,

CurretContral -~ nz G verdrlds,

nz onzlop ControlSourme tulujdonuign,

THIS onrlop ] AddORIECT vilana bATR""COMBOBOX")

THIS onzlop] CurrentControl = vAlunetd Al

THIS onglop! valanatdAln RowsoureeType = |
'I'IlIH.\Mlnpl.vl‘llnn‘xl(ﬁAI‘lLI(anmllw «"9.09, 10,71, 12, 25"

THIS onzlop] vilanatdAl Visible =T,

THIS onzlop], Spare =1, && o rdos minden sordben jelenik meg

A rhenhilon balali feltételon formizis (dinamikus tulajdonsagok)
Pl Szdm ke o o epylk oszlopa kifizetve” nzt jelzi, hogy az adott szamla ki van-e fizetve (T. vagy .F.). Aki
nem fizetelt tételékhez tartozd sorokat inverzben jeleniti meg:

THISFORM greid1 Set Al Dynam keBackColor”, ;

W kifizetve, RGB(255, 255,255, RGB(0,0,0) )" )
THISFORM,grid1.Set All(,DynamicForeColor™, ;

ST (kifizetve, RGB(255, 255, 255, RGB(0, 0, 0) )" )

A dinamikus tulajdonssgok hasznalata:
oszlop.DinamikusTulajdonsig="Log_Kifejezés”

Dinamikus tulajdonsagok listaja:

DynamicFontBold, DynamicFontItalic, DynamicFontStrike Thru,
DynamicFontUnderline, DynamicFontSize, DynamicAlingment,
DynamicFontName, DynamicBackColor, DynamicForeColor,

DynamicCurrenrControl

A récshilo vezérlés fontosabb tulajdonsagai

ChildOrder — az adatforrasanak indexe, amely kapesolddik a szilé tabla elsSdleges kulesahoz,

ColumnCount — oszlopok széma (ha =-1, akkor a tébla mezdinek szdma),

LinkMaster — a megjelenitett gyerek rekordok sziilé tablanak neve,

RecordSource — adatok forrdsa,

RecordSource Type - adatok forrasanak tipusa. 0 — Tébla. A VFP automatikusan megnyitja a RecordSoursce-
ban megadott tablat. 1- Alias (alapértelmezés) az adatforrds a RecordSource adhatd meg, 2 - Prompt. A
futési idében kéri az adatforrds nevét, 3 — Query, a RecordSource-ban egy .QPR file-t adunk meg.

ChildOrder — a kapesolodd tibla index Tag-ja,

Relational Expr — a gyerek tablat az elsédleges tablahoz kapesold kifejezés.

Az oszlop vezérlés fontosabb tulajdonsdgai:

ControlSource (altalaban egy tabla mezd),

CurrentControl (az oszlop altal tartalmazott objekiumok kézil melyiket hasznalja az adat megjelenitéséhez),
Sparse (ha =T, csak az aktiv cella hasznélja az adat megjelenitéséhez a CurrentControl-lal meghatdrozott
vezérlést, ha = F, - az 6sszes cellaba jelenik meg).

Adapheret haszndlata (tdrolé tipus). ~ kartonokra osztott dialégusablakok.
FogeC ount --a keret lapjainak szama,

Captfane g lap kartonfalén  megjelend szoveg,

Tl ch =] (Multiple Rows) tobbsoros szoveg,

Az aktiv Inp kivilasztisa,

Ablak. Lapkeret, ActivePage = 3
Inpkeret, PAGES(L), Ennbled = T,
Inpheret, PAGES(2),Caption = 2, Lap”

A lnpheret fontosnbb tuln) donsigal:
ActivePnge, Tubs (n kevet Inpjal rendelkeznek-e kartonfiillel), PageCount, TabStyle

A lap Tontosabb tulajdonsigal:
PageOrder, Pleture (BMP, vagy 1CO file).

AZ OLIE tarold vezérlésck haszndlatn
OLE throld vezérléssel OLE szervereket (Excel, Word, ... ) vagy ActiveX vezérléseket
lehet megjeleniteni (az ActiveX vezérlések a Windows Y STEM kényvtarban talalhatd OCX file-ok).

MESSAGEBOX alkalmazisa,
Pl. IF MESSAGEBOX('Kilépni?’, K1+K2+K3, Kilépés')=6
_ Screen. ActiveF orm. Release()
ELSE
_Sereen.ActiveForm.Refresh()
ENDIF

K1={0-OK, 1-OK és Cancel, 2 Abort, Retry, Ignore, 3~ Yes,No, Cancel, 4— Yes,No, 5- Retry,
Cancel },

K2={16-Stop, 32-7,48—1}.

Visszaadott érték

{1 - OK, 2-Cancel, 3 ~ Abort, 4 — Retry, 5 - Ignore, 6 — Yes, 7 No}

MENTU TERVEZES

Programbél: DEFINE PAD, DEFINE POPUP, DEFINE BAR.

Menu Designer-ben: menik, meniipontok, almeniik elhelyezkedése. T éjlokban tarolja: MNX (tdbla), MNT
(memo). A meniirendszert kell generalni - MPR — ezt a programot lehet futtatni.

Project Manager - Other -» menus : megnyilik a Menu Designer.

A Gyors Menii (vdlaszthatd, ha a meniistruktura iires).

a Menu Designer-» Quick Menu : megjelenik a VFP rendszer mentje.

Az elemek szévege — Prompt, tipusa — Result.

Options — rendelhetd gyorsito billenty(, stdtusz sor tzenet, az elem kivélaszthatosaga,

A mentpontok csoportositasa: -

Meniielem tipusanak megadisa: (Result oszlop).

Submenu (almenit), Command (parancs), Procedure (eljaras).

Az elemek kivilaszthatosigianak szabalyozisa,

A Prompt Options ablak Skip for vélasztomez8jére kattintva = Expression Builder : logikai kifejezést, amely ha
=T., akkor az ¢lem vélaszthatéd (=F., akkor, nem).

Statusz sav {izenet: A Prompt Options=» Message.

A meniik elhelyezkedésének meghatarozisa

A View menii General options pontjaban lehet valasztani:

Replace - az j meniirendszer teljesen feliilivja az aktiv meniirendszert,
Append - az ij meniirendszer Kiegésziti az aktiv meniirendszert,

Before — a VFP egyik meniieleme elé keriil,

After - a VFP egyik menfielem utin keril.

A meniirendszer SETUP kodja.
A menii program a SETUP kéddal kezdédik. A kéd létrehozasa: View -» General Options >Menu Code :
Setup valasztémezd. A SETUP-ba definialjuk a meméria valtozdkat, megnyitjak a sziikséges file-okat,...

Javaslat: CLEANUP kédban READ EVENTS, a Vége-ben: CLEAR EVENTS parancsokat helyezziik cl,
Javaslat: a Vége-ben: SET SYSMENU TO DEFAULT (!!!) visszadllitja a VI'P meniljét.

LEKERDEZES SQL létrehozisa
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1), Query Designer-ben lehet 1etrehozni, QPR file-ban
2). Query Wizard-dal, (Tools=> Wizards,,.) egyszerd lekérdezésokee alkalmas,

Lokérdesds terverds n QUERY Dosingner-rel

Project Maneger =¥ Dotn =»Quories = New  vagy

File = Quory =» New I'lle

Lehetdségoks Mezdk megadinn, rekordok kivalapztin, rekordok sorrendje, rekondok caoportonltinn és a
lokdrdozdn kimanaténak megncdinn

JELENTIS 68 CIMK K TERVEZESE (nyomintisen)
A felentén tervét o VP FRX (dblakban throljn (hozgd tartozik egy FRT memo file is),
A Jelentn figian Onelopon nearkeret (1 rekord 1 norba), Sor szerkezet (o rekord mezdi egymas alatt), Okmény
nzerke et (okmany kitoltd forma), Tabh onelopon szerkezet (o rekord mezdi egymas alatt, tobb oszlopban).
Clmke ( LDX dn LIT Nlecok) - egy rekord mezdi ogym in alatt egy esoportot alkotnak. Minden csoport kulon
otikattre koril

JELNTHS [etrehorin

n leport Wigard-dal, vagy

o Quilek Report menapontial, vogy
i Report Denlgner-ral

Report Wizmed; opyszerli jelentés (Report), egy-a-tobbhoz (One-to-Many).
Report Destgners Plle=>New = Report <> New.

CIMKE ltrehozhsa
Label Wizard : File=» New -> Wizard vagy
Label Designer: File=» New = New.

LAPBEALLITAS
Lap mérete, orientacioja (allo, fekve), a jelentés margoi és oszlopainak szama.

Papirméret és orienticio
File=> Page Setup = Print Sepup

A jelentés adatkiirnyezete (Data Environmeni Designer-rel)
View-> Data Environment

A jelentéshez tartozd valtozdk
Report menii = Variables (valtozd definiglasa, valtozok sorrendje, kezdeti értéke).

A jelentés savjai (BAND)

Title (Elsd lapon), Page Header (minden lap tetején), Group Header 1 { a csoport fejléc savja), Detail (mezik,
kifejezések), Group Footer 1 (csoport labléc), Page Footer (minden lap aljan ), Summary (a jelentés végén -
053Zegzés)

Title (Cim) - Report menii=» Summary/Title Bands

Page Header (Lap fejléc) — nem kell létrehozni, mert a jelentések mindig tartalmazzik
Column Header (Oszlop fejléc) — File->Page Sepup—> Column Number

Group Header ( csoport fejléc) - Report menii->Data Grouping

Detail band (részletezés sav) — nem kell 1étrehozni, mert a jelentések mindig tartalmazzak
Group Footer (csoport labléc) — Report menii->Data Grouping

Column Footer (Oszlop libléc) — File->Page Sepup—> Column Number

Page Footer (lap labléc) — nem kell létrehozni, mert a jelentések mindig tartalmazzak
Summary ( dsszegzés) — Report menii=» Summary/Title Bands

A Jelentés vezérlései:

Mezi (Tield) — Tabla mezd, valtozo, kifejezés
Cimle(Label) - Fix szdveg

Vonal (Line) ~ Egyenes

Négyuzig (Rectrangle) — Keret és szegély
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Lekerckitelt négyszig ( Rounded retrangle) — Kor, ovalis, lekerekitett sarki téglalop
Kép vagy OLE keret ( Picture/OLE bound) - Bitmap v. altalinos mezd

A mezd vezérlések hasznalata
Beszaras: Data Enviroment Designer-ben egérrel a mezét = a jelentésre.
A megjelent Report Expression ablakban megadjuk a mend nevét,

Oldalszamozds: a PAGENO nevii rendszer valtozét helyezzilk ré a jelentésre.

Kodlapok hasznilata

A kodlap bedllitisa a DB file-hoz. A VFP automatikusan bejeldli a tibla kédlapjat, A CPDBE()
fuiggvénnyel lekérdezhetd.

Az automatikus kddlap bedllitdsa: Tools=> Options—> Data=> Code Page (Set as Default gomb),
(NINCS!HIID

Uj kodlap beallitasa:

DO CPZERO WITH filenev, kddlapszam

A CPZERO talalhatd a VFP TOOLS\CPZERO konyvtardban,

Ha g képerny6héz v. a nyomtatora kikildstt adatokhoz nem adunk meg fontot, tgy a VFP a FOXPRO.INI-ben
talalhatd bedllitasokat hasznalja.

Az adatok sorrendje; Tools=> Options—> Data—> Collating Sequence (Set as Default)
v. PL. SET COLLATE TO ,,GENERAL”

Keresés.
Ajanlatos alkalmazni a SCAN v. LOCATE, mert figyelembe veszi a diakritikus jeleket.
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